
                                                      

PowerTracks Manual

MIDI Sequencing Software for IBM Computers

You may Print out this manual by choosing File | Print command in Windows Write .

See the last chapter for information on newest features added to the program

POWER TRACKS
PG MUSIC INC.

Program License Agreement
CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING ANY OF 
THE DISKETTES IN THIS PACKAGE. USAGE OF THE DISKS INDICATES YOUR 
ACCEPTANCE OF THE FOLLOWING TERMS AND CONDITIONS.
LICENSE
A. The program may only be used on a single machine.
B. The program may be copied into any machine readable form for backup purposes only in 
support of the program on a single machine.
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accept the terms of this Agreement. If you transfer the program, you must either transfer all 
copies, whether in printed or machine readable form, to the same party, or, destroy all copies not 
transferred. This includes all modifications and/or portions of the program merged into other 
programs.
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TERMINATED.
LIMITATION OF REMEDIES
PG Music's entire liability, and your exclusive remedy shall be:
A. The replacement of any diskette(s) not meeting PG Music's "Limited Warranty", which are
returned to PG Music, or an authorized PG Music Dealer, with a copy of your receipt,
- or -
B. If PG Music or the authorized dealer is unable to deliver a replacement diskette which is 
free of defects in materials or workmanship, you may terminate this agreement, and your money 
will be refunded.
IN NO EVENT WILL PG MUSIC BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING BUT 
NOT LIMITED TO LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR THE INABILITY TO USE SUCH 
PROGRAM, EVEN IF PG MUSIC OR AN AUTHORIZED PG MUSIC DEALER HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER 
PARTY.
PowerTracks is a trademark of PG Music Inc.
PowerTracks Program and Manual are Copyright 1992, 1993 by PG Music Inc.
IBM is a registered trademark for International Business Machines Corporation.
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Introduction 

PowerTracks is a full-featured 48 track MIDI sequencer for IBM compatible machines running 
Microsoft Windows 3.1. With PowerTracks, you can record music from your MIDI Keyboard and  
play back the music on your MIDI synth or sound card.  PowerTracks resembles a multi-track 
tape recorder, but also has extensive editing capabilities, similar to those found on a word 
processor, that let you make changes and corrections to the music. You can also display your 
music in standard music notation on the screen.

To use the program you require:

Windows 3.1, 2mb memory, 286/386 (or better)

MIDI System (MIDI Interface/MIDI Synthesizer)  or PC Sound Card

Headphones or stereo speakers.

Our goal in developing PowerTracks was to design a sequencer with powerful editing and 
synchronization capabilities, but which is easy to use. PowerTracks is simple enough for the 
beginner to use yet is powerful enough to satisfy a professional musician.

PowerTracks has all the standard sequencer functions such as cutting, pasting, event level 
editing, Standard MIDI File support, etc. In addition, PowerTracks has sophisticated features such
as search/replace, percentage quantization, selectable timebase resolution, multiple port support 
including dual MIDI output ports, MIDI Sync, and MTC/SMPTE sync.

Chapter 1: Installation and Driver Setup
Installing PowerTracks

Please read this entire section before beginning installation. 

Your distribution diskette contains the following files:

PTW.EXE - PowerTracks.
PTSEQ.DLL - The PowerTracks sequencer Dynamic Link Library.
PTW.HLP - The Help File.
PT.INS - Instrument file with Dump Request Macros in binary format.
PT.DRM - Dump Request Macros in ASCII format.
INSTALL.EXE - The installation program.

README.TXT
You should check the file README.TXT for any last minute changes to the manual. You can read
the file on your computer by running MS Write and selecting File | Open to load REAME.TXT into
Write, or by typing '"TYPE README.TXT' on the DOS command line.

To install PowerTracks, place the distribution diskette #1 in drive A: and select the Program 
Manager's Run command from the File menu. When the dialog box pops up, type A:INSTALL 
on the command line. The installation program will decompress the files and copy them over to 
your hard drive.
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Backing up PowerTracks
We recommend making a backup copy before using PowerTracks. 

Note: The backup copy, of course, should be for yourself only. You should not make 
copies for other individuals, since doing so would violate international copyright law. We 
hope you will respect our copyright and not take advantage the fact that we haven't used 
copy protection. 

Making a backup copy of PowerTracks:

First, place your DOS diskette in drive A: and then type "A:DISKCOPY" and press ENTER.

Next, just follow the directions that DISKCOPY gives you. You will be asked to place the "Source 
Diskette," which in this case is the PowerTracks distribution diskette, in drive A. When 
DISKCOPY asks for a "Target Diskette," place a blank diskette in drive A:. 

When the copy is finished, you may use the backup copy instead of the original distribution 
diskette.  Your original distribution diskettes should be stored in a safe place.

Note:  If you haven't done so already, we strongly recommend you back up all important 
files from your hard drive onto floppy disks or tape. It is better to be safe and know that 
you have backup copies of all important files should anything ever happen to them. 

Driver Setup
Setting up MIDI or Sound Card
PowerTracks uses the Multimedia drivers for your MIDI interfaces or sound cards that are 
supported by. Windows 3.1. To get PowerTracks' playback working properly you need to have a 
Driver installed for output. If you plan on recording melodies you will need a driver for input as 
well. 

Connecting PowerTracks to Your MIDI System

Example of connection for MIDI system with Roland MPU-401 & Synthesizer:

    1.                      2.                              3.                             4.                         5.
POWER            WINDOWS                   MIDI                          MIDI
TRACKS   +      DRIVER        +        INTERFACE     +    SYNTHESIZER    +  SPEAKERS
                      e.g. MPU401.drv         e.g. MPU401          e.g. Sound Canvas
   
1). PowerTracks (PTW.EXE) is run under Windows 3.1

2) The Windows Driver for your MIDI interface either comes with Windows 3.1, is included with 
your interface, or is available from the interface manufacturer. It is installed into the Windows 
Control Panel outside PowerTracks. You then choose the driver inside PowerTracks from the 
MIDI DRIVER menu. There is usually a separate driver for input (from your synth keyboard) and 
output (to your synthesizer).
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3) The MIDI interface transmits information between the computer and your synthesizer(s).

4) The Synthesizer produces the Sounds. PowerTracks tells it what notes to play.

5) Stereo Speakers or Headphones are connected to your synthesizer so that you may hear the 
music.

- OR -

Connecting PowerTracks to Your Sound Card

Example: connection of PowerTracks to your Sound Blaster Pro's FM Synth:

     1.                          2.                                3.                                              4.  
POWER       +     WINDOWS     +      PC  SOUND CARD            +           SPEAKERS
TRACKS                 DRIVER            e.g. Sound Blaster PRO FM    

The Sound Blaster may be used in 2 ways. You may use the MIDI outputs to connect to your 
MIDI synthesizer (see above) or you may use the internal FM sounds of the Sound Blaster.

Installing a Driver into Windows 3.1

This is done outside PowerTracks.  It is done in the Program Manager | Main | Control Panel | 
Drivers Program. From the Main Window of Program Manager double click on the Control 
Panel icon.  Double click on the Drivers icon.  A Drivers dialog box will appear with a list of 
installed drivers.  The following examples should provide you with step by step procedures for 
installing the most commonly used drivers.  

Example #1: Installing a MPU-401 Driver:

If you are using a MPU-401 MIDI interface you will need to install the "Roland MPU 401 MIDI 
driver" supplied with Windows 3.1 From the Control Panel | Drivers program, (Drivers Dialog Box)
choose ADD to add a driver. Next, choose Roland MPU-401 from the list of standard drivers. You 
will then be asked to insert your  Windows disk that contains the MPU401.DRV file. To complete 
installation you will be asked for the port address and interrupt # for the MPU-401. The port 
address usually is 330 and the IRQ interrupt usually is 2/9. 

Example #2 : Installing Sound Blaster driver for MIDI use:

Sound Blaster PRO: Use Sound Blaster 1.5 Driver or higher.
Sound Blaster: Use Sound Blaster 1.0.  If your Sound Blaster is a newer card  (July 91 or later) 
use Sound Blaster 1.5.

Older Sound Blaster cards (pre July 91) are not capable of simultaneous Input and Output If you 
have an older Sound Blaster you will use the 1.0 driver and will be able to play PowerTracks but 
not be able to  record melodies at the same time. Install the Sound Blaster driver in a manner 
similar to the MPU-401 driver as above. (The usual settings for the Sound Blaster  are port = 220 
and Interrupt = 5. DMA Channel 1)
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Example #3: Installing the Sound Blaster for use with FM sounds:

The Sound Blaster has a built in FM synthesizer  (11 voices; 22 on the SB Pro). These sounds 
are also Adlib compatible. If you wish to use the FM synthesizer then install either the Adlib  driver
(11 voices) or the "Creative Labs Sound Blaster PRO MIDI synthesizer driver".

Setting Up Your Drivers Inside PowerTracks

If you are running PowerTracks for the first time, the MIDI Driver Setup dialog box will 
automatically appear. Otherwise, choose Midi Driver Setup from the MIDI pull down menu. You 
will then see a dialog box with 2 lists.  Input drivers will appear in the left box and output drivers 
will appear in the right box.  Select the appropriate Input and Output drivers that you wish to use 
with PowerTracks.  If you are using Roland MPU 401 compatible equipment select Roland MPU-
401 for both input and output. PowerTracks supports multiple ports. Therefore, you may select 
more than one Input or Output driver assuming you have installed multiple drivers in Control 
Panel.
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Chapter 2:   Basics
This chapter provides a basic overview of some key aspects of PowerTracks' user interface. 

Help Facility
PowerTracks has a context-sensitive on-line help system. Pressing F1 in almost any part of the 
program will take you to an appropriate help topic. Some dialogs have a button instead of F1 for 
accessing Help.

The Menu Bar
The menu bar is located at the top of the opening screen. Like most Windows applications 
PowerTracks has a pull-down menu interface. You can access the menus by pressing  ALT-
<letter> with letter being the first letter of the menu you wish to activate. You can also activate the 
menu by clicking the left mouse button while the mouse cursor is directly over any of the menu 
names on the Menu Bar.

When you've selected one of the choices from the Menu Bar, a pull-down menu will appear. You 
may then choose a selection from the menu by one of three methods: 1) Moving the highlight bar 
over the desired selection and then pressing ENTER; 2) Pressing the key that corresponds to the 
highlighted character of the desired selection; 3) Moving the mouse cursor over the item you wish
to select and then by clicking the left mouse button. 

Tool Bar
The Tool Bar is located at the top portion of the screen, which is below the Menu Bar. 

PowerTracks has a set of buttons that resemble the controls on a tape machine that you can use 
for activating or stopping the sequencer.

There are two scroll bars below the transport buttons.  The one on the left reflects the current 
song location. The one on the right reflects the current tempo, which is shown in a  numeric box 
to its right. The scroll bars may be used to change the current location or tempo of the song.  

The tempo and song location can be changed during playback using the scroll bars. For example,
if you move the song location scroll bar during playback, the song will jump to the chosen location
within the song.  

The From and Thru fields show the beginning and end of the marked area within the song.

The Time field shows the current time within the song in SMPTE format.

The Now field shows the current time within the song in Measures:Beats:Ticks.

The current Key signature and Meter of the song are shown below the Now field. 

You can press the Punch button to toggle PowerTracks into or out of Punch In mode. See the 
Options Menu  section of the Commands Chapter for more information on Punch In Mode.
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You can press the  Solo button to toggle PowerTracks into or out of Solo mode. See the section 
later in this chapter on Solo Mode.

The Piano Keyboard

The piano keyboard is located below the tool bar. It will display notes being played by 
PowerTracks as green squares.  It can be hidden with the Options - Hide Piano command if you 
don't need it on the screen and you wish to have extra space for window placement below the 
tool bar.  See the Options section in the Commands chapter for settings regarding the Piano.

Command Shortcuts

You can access some of the commands in PowerTracks' menu system by using a shortcut 
(sometimes called accelerator) key command. For example, you can open a file by pressing F3,  
If there is shortcut for a menu command, it will be shown to the right of the command's name in 
the pull down menu.

Note: Command shortcuts will not work while inside the Comments window, since many of
the short cuts would conflict with editing the text. 

Function Keys
The function keys provide quick access to some of PowerTracks' commands. The following is a 
list of each of the commands that you can access via the function keys:

F1 On-line Help F6 Go to Time
F2 Open a new Event List Window  F7         From = Now
F3 Open file F8 Thru = Now
F4 Save file F9 Panic Button (notes  off)
F5 Tempo
            
Note String Fields
Some dialog boxes have fields in which you are required to enter note information. A note string 
consists of the note, a sharp (#) or flat (b) symbol, and the number of the octave of the note. Note
strings range in value from "C 0" which is the lowest note, to "G 10" which is the highest note. 
Middle C is "C 5". You can specify either Sharps or flats when entering note strings, (For 
example, "F#7" is the same as "Gb7"), but the pitch will be displayed as either a sharp or a flat 
depending on the key signature of the song.

Time Display Formats
The Time and Now  display windows are located at the far right of the Tool Bar.  PowerTracks 
normally displays event times in the form of Measures:Beats:Ticks. For example, the start of the 
song is displayed as "1:01:00". 

If you have set the time display mode to "SMPTE", the Event List window will display event times 
in Hours:Minutes:Seconds:Frames. Also, if you've set the time display mode is to "SMPTE", the 
From and Thru markers will be displayed as SMPTE times.

See the Options section of the Commands chapter for more information about SMPTE.
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File Formats
PowerTracks will load and save PowerTracks Files (which have a .SEQ extension), as well as 
Standard MIDI Files .

PowerTracks Files are PowerTracks' native file format. Features such as track looping, 
comments, and banks of system exclusive are all saved to PowerTracks Files. 

Standard MIDI Files are a standardized format agreed on by the International MIDI Association. 
Many sequencers support this format, thus making it possible to transport song files between 
sequencers. If you save a song to a Standard MIDI File  PowerTracks can't save information such
as track looping, comments, initial program change, and system exclusive. PowerTracks can't 
save pitch and velocity transposition settings into a .MID file. However, if any tracks make use of 
pitch or velocity transposition, PowerTracks will automatically transpose the track data as it is 
being saved. 

The Icon Row
There is a row of icons at the bottom of the PowerTracks opening screen.  Reading from left to 
right they are as follows:  Bars, Meter Map, Tempo Map, Comments, Guitar, Sys Ex. and 
Mixer  
You can open a window by double-clicking on the icon.

Loading a Song
You can load a song by pressing Alt-F to activate the File Menu, and then choosing the Open 
menu selection. A dialog box will pop up, which will display  all .SEQ and .MID files within the 
current subdirectory. Simply choose the file you wish to load, and PowerTracks will load the file 
into memory.  

See the File Menu section of the Commands chapter for more information on loading files.

Playing a Song
You can activate playback by pressing the PLAY button in the tool bar.  

Recording
You can activate Recording by pressing the RECORD button . 

You can stop playback or recording by pressing the STOP button or the SPACE bar.

See the Action Menu section in the Commands chapter for commands related to playing and 
recording.

Selected Tracks
The editing routines only affect the selected tracks.  Selected tracks are indicated by the track's 
number being highlighted.  
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The Current Track
The current track is the one that is highlighted in the same color as the window's title bar. For 
example, if the window's title bar is blue, the current track's number ( located on the far left side of
the Tracks Window) will be highlighted with the color blue. The current track also happens to be 
the one that contains the input focus rectangle in the Tracks window. You don't have to select the 
current track because PowerTracks will select it automatically.
 
Selecting Multiple Tracks

If you hold down the shift key while pressing the up or down arrow key to move to a different 
track, the current track will remain selected. The ctrl key has the opposite effect. If you move 
away from the current track while holding ctrl, the current track will be de-selected. You may also 
use the mouse to select multiple tracks by clicking the left mouse button and holding it down while
the cursor is over a track and then dragging the mouse cursor either upward or downward.
You can use the slash key (/) to force the current track to be the only selected track.

Solo Mode
You can toggle PowerTracks in and out of Solo Mode by pressing the SOLO button. When in 
Solo Mode, you will only hear the current track (assuming you haven't muted it). You won't hear 
any of the other tracks. The Solo button will remain pressed  to indicate PowerTracks is in Solo 
Mode.

Using the Editing Routines
Before executing an editing routine (in the lower portion of the Edit Menu), first mark the area of 
the song you wish the routine to edit.

Marking a section of a Song:  Use the F7 and F8 keys to set the From and Thru values to the 
current time. This method of marking is most useful from within the Bars window or the Event 
Editor. Simply move the cursor to beginning of the area you wish to mark and press F7. Then, 
move the cursor to the end of the area you wish to mark and press F8. 

You may also mark an area of the song by directly specifying the values for From and Thru. Ctrl-
F7 and Ctrl-F8 are two command shortcuts for directly specifying From and Thru. After entering 
either of these two key combinations, a small dialog box will pop up and you may enter a time 
value.

You can mark a section of a song in the Bars window by clicking and holding the left mouse 
button and then dragging the mouse cursor.  For example, if you click the mouse when the cursor
is in the column with measure 5 and then drag the mouse cursor to the column with measure 10,  
PowerTracks will mark measures 5 through 10. 

When in the Bars window, the marked area will be highlighted. When in an Event List, events that
are within the marked area will have a black rectangular box to the left of them. 
 

Once you have marked a section, you may use one of the editing commands such as copy or cut,
and the chosen command will only affect marked area of selected tracks. (See the Edit Menu and
Block Menu sections in the Commands chapter for more information on editing)
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Chapter 3: Commands             

This chapter will discuss the pull-down menu commands. It is divided into separate sections for 
each of the menus. 

The File Menu
The File Menu contains commands that are related to files.  

New

This command wipes the current song from memory so that you may start a new song. If you've 
changed the song since you last saved it, PowerTracks will ask you whether or not you wish to 
save the changes before wiping the file from memory.

Open

This command will load either a .SEQ or .MID file. A dialog box will pop up which has two list 
boxes; the left list displays all the .MID and .SEQ files in the current directory, and the right list 
contains the directories. 
If you move the highlight bar over the desired choice and either press ENTER, or click  on the   
OK Button PowerTracks will load the file. A file can also be loaded by typing its name directly in 
the file name field instead of using the list box. You may use the mouse to select a file bydouble-
clicking the left mouse button. 

You can also restrict the type of file you're looking for to PowerTracks files (.SEQ) or MIDI files 
(.MID) by clicking on List Files of Type and highlighting the appropriate file type.

Save

This command will save your work under its current name. If the current song has no name, a 
dialog box will pop up so that you may choose a file name and file format (.MID or .SEQ). See the
Save As command for more information on choosing a file name and file format.

Save As

The Save As command is similar to the Save command, but it lets you choose the name of the 
file before saving it.

PowerTracks can save files either in .MID or .SEQ format. A dialog box, which looks similar to the 
File Open dialog, allows you to choose the name of the file and the directory, drive, and file type. 
If you choose to save over a file that already exists, the program will prompt you to make sure 
you want to overwrite the existing file.

Load Scrap

This command works the same way as the Open command, except that the .MID or .SEQ file is 
loaded into the scrap buffer. You may then paste the contents of the scrap buffer anywhere within 
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the song. This is useful for importing a file into the current song.

Save Scrap

This command works just like the Save As command, but saves the contents of the scrap buffer 
to a .MID or .SEQ file. This is useful for exporting part of your work.

Load Mixer Settings

This command works like the Open command except that it loads the settings of the Mixer 
Window.  The file extension for the mixer settings is '.MS'.  PowerTracks will automatically send 
the settings to your synth after the file is loaded.

Save Mixer Settings

This command works like the File - Save As command except that it saves the settings of the 
Mixer Window to a .MS file. You can then reload the settings at a later time using the Load Mixer 
Settings command, and the saved settings will be restored. 

Exit

Exits PowerTracks. If you've changed your work since you last saved it, PowerTracks will ask you
asked whether or not you wish to save the file before exiting.

The Edit Menu
The Edit Menu contains commands that are related to editing the song.  This menu has standard 
editing routines such as cutting, pasting, quantizing, etc. The editing commands affect the marked
area of all selected tracks. You can undo any of the commands.

Quantize

The Quantize command rounds the times of notes to the nearest specified time interval. This is 
very useful for correcting timing errors in your music. Both the start times and durations of the 
notes can be quantized. The resolution will determine the degree to which PowerTracks rounds 
the timing. For example, if you choose a resolution of a sixteenth note, PowerTracks will round 
the notes in the marked area to the nearest sixteenth note. You may choose a resolution from a 
whole note down to a 32nd note.

The percentage option will allow you make the timing of your music more accurate without 
sounding too mechanical. For example, if you chose an interval of a sixteenth note, a percentage 
of 50% will move the notes 50% closer to the nearest sixteenth note instead of moving the notes 
exactly to the nearest sixteenth note. 

You can use the Data Filter to determine which notes will be affected by the Quantize command.

To access the Quantize function simply click on Quantize from the Edit menu.  The Quantize 
dialog box will appear.  Make the appropriate selections and click on OK.

15



Copy

This command works differently depending upon which window is active. If you are working in the
Comments window, this command will copy the selected text to the clipboard.

Otherwise, this command copies the marked area of selected tracks and places the copied 
events in the scrap buffer. You may then use the Paste command to paste the contents of the 
scrap buffer anywhere within the song, or you may use the Save Scrap command to save the 
contents of the buffer to a file. You can use the Data Filter to determine which events to copy. 
This command also automatically copies the events into the Windows clipboard so that you may 
paste the events into another Windows application that supports pasting Standard MIDI Files 
from the clipboard. 

Cut

This command works differently depending upon which window is active. If you are working in the
Comments window, this command will cut the selected text to the clipboard. Otherwise, this 
command deletes MIDI events from the marked area, and moves them to the scrap buffer. As 
with copied events, deleted events can later be pasted to any location, or saved to a file with the 
Save Scrap command.

Options:  When PowerTracks cuts the events, it will create a gap in the selected tracks of the 
song. You have a choice of keeping or closing the gap that PowerTracks created after the cut. 

Another option is to use the Data Filter to determine which events to cut. If you use the Data Filter
PowerTracks will cut some events and will leave some events untouched depending on whether 
or not they "pass through" the filter.

This command also will automatically place the cut events into the Windows clipboard in .MID 
format so that you may paste the events into another Windows application that supports pasting 
Standard MIDI Files from the clipboard. 

Paste

This command works differently depending upon which window is active. If you are working in the
Comments window, this command will paste text from the clipboard into Comments.

Otherwise, this command pastes the contents of the scrap buffer to the current location in the 
song. The repetitions option will cause the paste to repeat for as many times as you specify. The 
Options field gives you 3 choices:

1) Merge the Paste with existing data. 

2) Create a Gap on the currently Selected Tracks.

3) Create a Gap on all tracks.

This command can also paste a Standard MIDI File from the Windows clipboard to another MIDI 
application capable of copying a Standard MIDI File to the clipboard, such as Band-in-a-Box.   
Keep in mind that this command currently does not paste tempo and meter changes.

16



1-Track Paste

Same as the Paste command, but PowerTracks pastes all the data onto one track. You must 
select only one track and no more or this command won't be executed by PowerTracks.

Replace

This command will search for any type of event you specify and replace the events that 
PowerTracks finds with new ones. As with other commands, the replace command affects only 
the marked area of all selected tracks. 

PowerTracks will prompt you for the type of event to search for followed by the search ranges. 
Next, you will be prompted for: 1) the type of event with which to replace the found events, and 2)
the replacement ranges. Pressing ESC at any time will take you back to the previous step. 
PowerTracks will change the events that match the search criteria to the kind of event you 
specified as the replacement event type (assuming you didn't select the same replacement type 
as the search type). In addition, PowerTracks will re-map the values of these events from the 
search ranges to fall within the replacement ranges.

Pitch Transpose

This command transposes notes in the marked area of all selected tracks by the specified value. 
For example, if you specify a value of "-12" PowerTracks will transpose the notes down one 
octave. You may use the Data Filter to determine which notes to transpose. 

Fill

This command will insert a stream of either controller, pitch bend or channel aftertouch events. 
You can use Fill to do things such as fade-ins, fade-outs, pitch bends, etc. PowerTracks will 
prompt you for the type of event to fill and a start and end value. Then PowerTracks will 
automatically insert the events throughout the marked area of the song. The values of the 
inserted events will gradually increase from the start value to the end value. 

Length

This command alters the length of the marked area of all selected tracks by the specified 
percentage. For example, 50% will shorten the length by half. You can use the Data Filter to 
determine which events are affected by this command.

Slide

This shifts the time values of the events within the marked area of all selected tracks by the 
specified value. The value can be positive or negative. A positive value will slide the events 
forward in time and a negative value will slide them backward in time. You may use the Data Filter
to determine which events are slid by PowerTracks. 
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Undo

This command will undo the last edit command executed from the lower portion of the Edit Menu. 
It will restore the tracks that were affected by the last edit command to their previous state.  If you
are working in the Comments window, this will undo the last text edit command.

The Undo command itself can be undone. If you've just executed the Undo command, it will 
appear in the menu as 'Redo'. The Redo command simply re-executes the command that was 
just undone. 

If you execute a command and there won't be enough memory to be able to Undo the command, 
PowerTracks will warn you beforehand. If you receive such a warning, it might be a good idea to 
save your work to disk before executing the command if you aren't certain what affect the 
command will have on your work.

Data Filter

The Data Filter is a filter that, when in use, determines which events will be affected by the 
current edit command. PowerTracks will only allow the events that match the chosen 
characteristics to "pass through" the filter so that the current edit command can act upon them. 
The filter has a separate row for all six types of MIDI events. Within each row are settings that 
determine whether a type of event will pass through the filter, and the ranges and values of the 
events that PowerTracks will allowed to pass through. There is also a row within the filter that lets 
you specify which MIDI channels will pass through the filter. 

The Use column determines whether or not an event type will pass through the filter. If the Use 
column is checked, the event type will be used, but if it isn't checked the event won't pass through
the filter. For example, if the use column in the Note row is not checked then note events will not 
pass through the filter. 

The Range column determines what range of events will pass through the filter. For example, if 
the minimum for the note range is 'C1' and the maximum is 'C2' only notes that fall within the 
range of C1 through C2 will pass through the filter. The current edit command will not affect any 
notes lower than C1 or higher than C2. 

The Value column works in the same way as the range column, but will act upon note velocities, 
controller values, or aftertouch values. Only events with values that fall within the specified values
will pass through the filter. For example, if the minimum note value is 50 and the maximum is 100,
then only notes with a velocity of 50 up to a velocity of 100 will be pass through the filter. 

A Secondary Filter is a second Data Filter that you can use in addition to the regular filter. If you 
check the "Use Secondary Filter" option at the bottom of the filter, then a second filter will pop up 
after you're done editing the regular filter. Events that pass through either the regular or 
Secondary Filter will be affected by the current edit command. 

The purpose of the Secondary Filter is to let you choose two separate sets of ranges. For 
example, you could specify a note range of C1 to C2 in the regular filter, and a note range of C7 
to C8 in the secondary filter. Notes that fall within either range will be affected by the current edit 
command but notes that don't fall within either of these two separate ranges won't be affected at 
all. 
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The Track Menu
This menu contains the following commands, which are related to tracks:

Duplicate

This makes an exact copy of a track. You must select only one track or this command won't 
execute since this command is for duplicating one track at a time. PowerTracks will be prompt 
you to select a destination track. The destination track must be empty.

Erase
This command permanently kills all selected tracks, and resets their track setup values to 0. 
PowerTracks will ask you whether or not you wish to erase all selected tracks. If you erase them, 
you can't get them back. 

Erase Data Only

This command works the same as the Erase command except that it will not erase the settings in 
the Tracks Window such as the Track Name, Channel, Velocity, etc.

 The Action Menu
This menu contains commands that mainly deal with recording or playback.

Play

You can start playback by using this command by pressing the SPACE bar, or by pressing the 
PLAY button. You can stop playback by using the stop command, or by pressing the SPACE bar, 
or by pressing the STOP button. 

For information about playback with the Sync Source set to MIDI or MTC/SMPTE, please see the 
Synchronization chapter.

Play From Start

This command will play back the song from the beginning. 

Record

You can start recording either by using this command or by clicking on the RECORD button. 
Recording can be stopped by hitting the SPACE bar, or by pressing the STOP button. If 
PowerTracks recorded any MIDI events you will be asked whether or not you wish to keep the 
take. See the Mixer Window later in this chapter for information about recording mixer moves.

For information about Recording with the Sync Source set to MIDI or MTC/SMPTE, please the 
Synchronization chapter.
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Record From Start

This command will start recording from the beginning of the song.  

Step Record

This command allows you to record a song one step at a time, as opposed to a normal real-time 
record. Each time you play something on your keyboard the sequencer will record the event with 
a time value representing the current location in the song (Now). 

Choosing a Step Size:  To choose a step size, click the mouse over the desired step.  The STEP
RECORD dialog box  lists the Step sizes in the left box and Duration in the right box. 

Durations:  Durations are chosen exactly the same way as step sizes. The "Step Size - 1" 
option will automatically make the durations 1 tick less than the Step Size. This is a convenient 
way of making the durations automatically match whatever step size you choose.

Auto Advance:  When Auto Advance setting is checked, the time will automatically advance to 
the next step after you play a note or a chord. You will see the Now: and Time: fields on the tool 
bar change when the time advances.

Dotted Step:  When Dotted Step is enabled, the step size will be 1.5 times the regular step size. 
(Example: a dotted eighth note is equal to 3 sixteenth notes) 

Go to:  You may use the Go to key  to move to a new  location.

Backup and Advance:  The  <Backup and Advance> buttons allow you to move forward and 
backward in time by one step.

When you are finished with step record, press the OK button, and the take will be kept. Pressing 
the Cancel button will cancel the step record without keeping the take.

Stop

This command simply stops the sequence from playing or recording.

Go to Time

This command lets you go directly to any time within the song. You can also use the F6 function 
key to activate this command. If the Display Mode (in the SMPTE section of the Options Menu) is 
set to "Normal" then the time is expressed in Measures:Beats:Ticks. If the Display Mode is set to 
"SMPTE" then the time is expressed in Hours:Minutes:Seconds:Frames.

Panic

This command will send an All Notes Off and a Sustain Pedal Off command over all 16 MIDI 
channels. It will also shut off any MIDI Thru notes that are currently sustained. This command is 
the same as pressing the  panic button.
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The Block Menu
The Block Menu contains some commands that deal with marking an area (or block) of the song. 
The editing commands of the Edit Menu will affect the marked area.

From = Now

This command sets the beginning of the marked area to the current time. 

Thru = Now

This command sets the end of the marked area to the current time.

From = Value

This command lets you directly specify the From time value. A dialog box will appear, and you 
may enter the new time.

Thru = Value

This command lets you directly specify the Thru time value. A dialog box will appear, and you may
enter the new time.

The Options Menu

The Options Menu has various settings that affect PowerTracks. Most of these options are stored 
within a song when it is saved to a .SEQ file, but only some of these options are saved into 
a .MID file. 

Tempo

This command allows you change the current tempo of the song. You may choose a tempo value 
of 8 to 500. PowerTracks will automatically change the current tempo entry in the Tempo Map to 
the tempo that you select.

Meter

This command lets you change the current meter. The Meter Map event for the current time will 
be automatically be changed. The numerator may be from one to 99. You can change the 
denominator via the drop down combo box. 

Key Signature

This allows you to choose the key signature of the song. This setting will affect whether 
accidentals are displayed as sharps or flats. Simply pick a key signature from the drop down 
combo box.
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Metronome

This command lets you configure the MIDI metronome. The metronome can be active during 
recording, playback or both. 

Recording:  If this option is enabled then the metronome will be on during recording.

Playback:  If this option is enabled then the metronome will be on during playback.

PowerTracks will send a specific note out via MIDI on each beat. The note, velocity, duration 
and port options will determine the pitch and characteristics of the note that is sent out via MIDI 
on each beat of the song. 

Count In: This option lets you choose how many measures will be counted down before 
recording begins. The countdown may range from 1 to 4 measures.

SMPTE

This option lets you choose the time display format, as well as whether or not PowerTracks 
displays MIDI events as SMPTE times. 

Time Display Mode: If the time display mode is set to Normal, PowerTracks will display the time 
in Measures:Beats:Ticks. When set to SMPTE, the time will be displayed as Hours: 
Minutes:Seconds:Frames. 

SMPTE Format: You may choose one of four SMPTE formats: 30 Frame Non-Drop, 30 Frame 
Drop, 25 Frame, or 24 Frame.

SMPTE Offset: determines the SMPTE time that PowerTracks associates with the beginning of 
the song. For example, if you use an offset of 00:00:02:00, the start of the song will be 
00:00:02:00. This gives the program two seconds to sync up to the tape when starting the tape 
from the beginning.

See the Synchronization Chapter for further information about SMPTE.

MIDI Out

This command deals with various settings that affect MIDI output.

Send SPP: determines whether or not MIDI Song Position Pointer is sent.

SPP Locate Delay: the delay time (in milliseconds) before play is started after sending Song 
Position Pointer. This gives MIDI devices some time to find the proper location when syncing to 
PowerTracks.

Send Realtime Messages:  when this option is enabled the sequencer will send MIDI clocks as 
well as Start, Stop, and Continue.

Send Most Recent Patch/Wheel/Controller:  When this option is enabled the sequencer will 
search back through the tracks for the most recent patch, wheel (pitch bend), and controller 
events, and will send them before starting playback. This insures that you will hear the proper 
sounds when playing from a new location within the song.
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MIDI Thru

This command lets you enable or disable MIDI Thru, and allows you to choose how the data is 
echoed. There are two types of MIDI Thru: Track-Specific and Global.

Enable Thru: If this option is checked then MIDI Thru will be enabled. If this option is not 
checked then MIDI Thru will be disabled.

Thru Method:  There are two types of thru methods, as discussed below:

Track-Specific:  When Track-Specific MIDI Thru is enabled, PowerTracks will echo the incoming 
MIDI data using the forced Channel, Velocity, Key, and Port settings of the current track. If 
these settings are set to 0, the MIDI data will be echoed out unchanged. For example, if the 
current track has a forced MIDI channel of 2, all incoming MIDI events will be echoed out via MIDI
on channel 2.

Global:  When Global MIDI Thru is enabled, PowerTracks will echo incoming MIDI data using the
forced Channel, Velocity, Key, and Port settings that you specified in the MIDI Thru entry box. If 
these settings are set to 0, the MIDI data will be echoed out unchanged.

MIDI Devices

This command lets you choose the MIDI input and output drivers to use with PowerTracks. A 
dialog box will pop up which contains two list boxes; one for the input drivers and one for the 
output drivers. Choose the ones you wish to use with PowerTracks. You can select more than one
input or output driver, since PowerTracks supports multiple ports.

See page 7.
for more information on setting up MIDI drivers.

Patch Names

PowerTracks lets you associate a list of names to patch numbers. The default setting is 'Numeric',
in which case you will select patches as numbers rather than from a patch list.  We have included
a General MIDI patch list, which is a standard set of names used in many newer synthesizers.  
The Numeric Range setting in the dialog lets you choose whether the numbers range from 0-127 
or 1-128 when the patch names are set to 'Numeric'. 

If you're using a patch list, the number range is based on whether the first name in the list was 
assigned a value of 0 or 1 in the file PATCHES.INI.

PATCHES.INI is a text file which defines the lists of patches.  You could add a new patch list by 
typing the names in PATCHES.INI. If you examine the PATCHES.INI file, you'll find information 
about the file format.    

Punch In
This allows you to enable or disable Punch In. When Punch In is enabled, recording will take 
place during the period between From and Thru and will overwrite any existing events during that 
time. When Punch In is disabled, recording may occur at any time within the song and the data 
will be merged with any existing events.
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Note: The From and Thru settings for Punch In are NOT the same as the From and Thru 
settings used for editing. 

Resolution

This option allows you to change the timing resolution in pulses per quarter note (PPQ). Simply 
pick a resolution from the menu, and the program will automatically convert the song to the new 
resolution.

Sync Source
This option determines which clock source will handle the timing of the music. 

Internal: When set to internal, PowerTracks will handle the timing. The following two settings are 
used when syncing to external devices:

MIDI:  When the Sync Source is set to MIDI, the program will use song position pointer and MIDI 
clocks as the clock source. 

MTC/SMPTE:  When the Sync Source is set to MTC /SMPTE, the program will use MIDI Time 
code as the clock source. 

This option is saved automatically to PTW.INI so that it will remain in effect the next time you use 
PowerTracks.

See the Synchronization chapter for more details on Sync Source.

Auto Sync Chase

This option is useful when syncing the sequencer to an external device, such as a drum machine 
or tape deck, during playback. When Auto Sync Chase is enabled, it allows for hands-free sync 
chasing to the external device. For example, if the sequencer is playing while synced to a tape 
deck, and you stop the tape deck, PowerTracks will await the MIDI Sync or MTC without you 
having to press PowerTracks' Play button. When you start the tape deck again, PowerTracks will 
automatically sync to the tape deck. When this option is selected a check mark will appear next to
the menu item. 

This option is saved automatically to PTW.INI so that it will remain in effect the next time you use 
PowerTracks.

Hide Piano

This option lets you hide the piano keyboard from the screen.  When the piano is hidden there will
be a little more space available for the placement of the windows below the tool bar.  This menu 
option will read 'Show Piano' when the piano is hidden. 

This option is saved automatically to PTW.INI so that your preference will remain in effect the 
next time you use PowerTracks.
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Piano Settings
This command lets you change the piano display mode.  There are two display modes for the 
piano.  When the display mode is set to 'Current Track', the piano will display notes as they are 
being played from the current track.
 
If the display mode is set to 'All notes except for drum channel', the piano will display notes that 
are played from all the tracks except for notes that are on the drum channel.  The default drum 
channel is channel 10, but it can be changed to any MIDI channel between 1 and 16.  If you 
select a drum channel of zero, then the piano will display all notes that are being played 
regardless of the MIDI channel.

These settings are automatically saved to PTW.INI so that they will remain in effect the next time 
you use PowerTracks.

Default Options

PowerTracks will attempt to load a file called $OPTIONS.SEQ" when the program is started, and 
when the File-New command is executed. This is a convenient way for you to change the default 
options.  

Note: When PowerTracks automatically loads $OPTIONS.SEQ upon start-up, the file name 
will still be 'untitled'. 

Simply save a file as $OPTIONS.SEQ, and all the current options will be automatically loaded 
when PowerTracks is started. If you save MIDI data to $OPTIONS.SEQ, the data will be loaded 
too, but you probably will want to just save a blank song without any data so that just the options 
are loaded when the program begins.  Keep in mind that some options, such as MIDI Devices, 
Patch Name settings, Piano Settings, Sync Source, and Auto Sync Chase are stored in PTW.INI 
instead of in .SEQ files.

The Window Menu
The Window Menu contains commands that deal with creating, selecting, and arranging windows.

New

Some types of windows allow you to open more than one instance at a given time. The New 
command deals with the creation of a Window that allows multiple instances. The Event List 
window is currently the only one of PowerTracks' windows that falls into this category. When you 
choose the New command a sub menu will appear with 'Event List' being the only choice. Select 
this command to create a new Event List.

Event List

An Event List window is an event editor that lets you insert or delete MIDI events, and lets you 
make changes to existing events. A list of events is displayed vertically in a window, with each line
in the list representing an individual event. Each event is shown with its track number, time, MIDI 
channel number, the kind of the event, and the parameters of the event. 
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When an Event List is created, it is based on the tracks which are currently selected.  For 
example, if only track 1 is selected, and you use the New command to create an Event List 
window, it will only deal with events that occur in track 1 as shown above. 

You can also open an Event List while multiple tracks are selected.  In this case, the Event List 
will deal with events in all the tracks which where selected at the time of the creation of the Event 
List window.  For example, if tracks 1 through 3 were selected when you created an Event List 
window, the Event List will deal with events occurring in those 3 tracks regardless of what tracks 
you've selected after it was created.

Events may be inserted by pressing the INS key. After pressing insert, a menu will pop up, and 
you may choose which type of event to insert. After picking the kind of event to insert, an entry 
box will pop up which will let you choose the MIDI channel, time, and any other parameters of the 
event.

Events may be deleted simply by pressing the DEL key.

Existing events may be edited by pressing the ENTER key. After pressing ENTER, an entry box 
will pop up, and you may make changes to the event.

You can play events one at a time by pressing the Transmit button. If the event you're playing 
isn't a note, the cursor will be advanced to the next event, but if the event is a note, it will be 
sustained until any other key is pressed. 

You can stop a sustained note from sounding by pressing the Silence button.  The sustained 
note will also stop in other situations, such as when you switch to a different window or choose a 
different event list command.

Types of Events

Note events consist of three parameters:

 - Note string: shows the name of the note and its octave.

- Velocity: the speed that the key was pressed.

 - Duration: the length of the note.

Controller Change events consist of 2 parameters:

 - Controller number: a number ranging from 0 to 127.

- Controller value: a number ranging from 0 to 127

Program Change events consist of 1 parameter:

 - Program number: a number ranging from 0 to 127 or 1 to 128.  The range
   depends on which patch list is currently selected, or which numeric range
   is selected if you are using the Numeric patch list. See the Patch Names
   command in the Options section of the Commands chapter for more
   information about Patch Lists.

Pitch Bend (wheel) events consist of 1 parameter:
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 - Bend level: a number ranging from -8192 to 8192, with
    0 representing the wheel being in the center position.

Channel Aftertouch events consist of 1 parameter:

 - Aftertouch level: a number ranging from 0 to 127.

Key Aftertouch events consist of 2 parameters
  
- Aftertouch level: a number ranging from 0 to 127. 

  - Note string: the note which the aftertouch will affect.

Tile

The Tile command will arrange the PowerTracks' windows so that an equal portion of each 
window is shown on the screen.  The windows will be aligned horizontally adjacent to each other.

Cascade

The Cascade command arranges PowerTracks' windows on screen one behind the other with the
current window shown in full and the title bar highlighted.  To switch to another window click on 
any part of its title bar.

Arrange Icons

The Arrange Icons command simply positions PowerTracks' icons ( e.g. Meter Map, SysEX etc.) 
so that they are neatly arranged along the bottom of the Main Screen.

Close All

This command simply minimizes all of PowerTracks' windows so that they are shown as icons. 

Tracks Window
This is the window which is shown when you first start PowerTracks. It shows the tracks with their
names and various settings.

Selected Indicator: The first column (far left)in the track view indicates whether or not a track is 
selected. If a track is selected, its number will be highlighted. The current track will be highlighted 
in the same color as the window caption, and an input rectangle will appear over the current edit 
field.  (See the PowerTracks Basics chapter for information about selecting tracks)  

Play Status:  The Play Status field shows the current status of the track. A track can be in one of 
three states: Play (P), Muted (m), or Frozen (f). By pressing the plus (+) or minus (-) keys while 
the cursor is over the status field, you will be able to toggle the status of a track. Tracks with a 
Play (P) status will be heard. Muted tracks will not be heard, but the data will still be processed so
that you may switch the track back into (P) status at any time during play/rec. Frozen tracks are 
not heard and not processed. Since frozen tracks aren't processed, there is less work for the 
sequencer to do during playback. If you have some tracks that you wish to keep for backup 
purposes but don't need them to be heard, you can save the sequencer some work during 
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playback by freezing the tracks. You may only toggle a track into or out of frozen status while 
PowerTracks is stopped.

Editing Fields within the Tracks window: The following fields may be edited by moving the 
cursor over the particular field you wish to edit and then pressing ENTER, or by double clicking 
the mouse while over the field. Numeric fields may be incremented or decremented by pressing 
the +/- keys.  

Track Name: The name of a track.

Events: The number of events in a track.

Ch: Forced MIDI channel. When not set to zero, all events in a track will be sent out over the 
selected channel.

Key:  Forced Key Transposition. This setting transposes the events in a track up or down by 
whatever amount you specify. (example: -12 will transpose down by 1 octave)

Vel:  Forced Velocity transposition. This setting increases or decreases the velocity of the notes 
in a track by whatever amount you specify.

Port: Determines which MIDI port the data in a track is sent out. If the port selected is greater 
than the number of available output ports, the events in the track will be sent out the highest 
available port. For example, if only one port is available, and you select port number 2, the events
will be sent out of port number 1.

Program change. When this setting isn't disabled, a MIDI patch change will be sent at the start 
of the song. When you change this setting, a program change will be sent out via MIDI. This is 
convenient for 'auditioning' sounds during playback.

Bank Select. This will send a bank select message followed by the track's current Program 
Change setting.  Some synthesizers have more than 128 patches.  These additional patches on 
some synths can be accessed by sending a bank select message which will cause the synth to 
switch to a different bank of patches.

Loop: When this setting is enabled, the track will automatically repeat for the number of times 
specified. The track will loop back to the start of the measure that contains the first event in the 
track. If this setting is set to zero, the track will not be looped.

Note:  Loop information is not saved to .MID files. If you are working with .MID files, you 
should use the paste command to repeat a passage instead of looping.

Bars Window
This window shows the bars (or measures) of the song. Bars that have MIDI data will be shaded, 
while bars without any data are not shaded. 

The horizontal  scroll bar allows you scroll away from the current location in the song.  Keep in 
mind that scrolling the Bar Window won't change the current location in the song.  Instead, you 
should use the scroll bar in the bottom left corner of the tool bar to scroll to a new location.  
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Note : See the Basics chapter for information about marking a section of the song for 
editing.

Meter Map
The Meter Map is a list of all the meter changes that occur during the course of the song. The 
Ins, Del, and Change buttons contained in the Meter Map dialog box may be used to insert, 
delete, and change entries in the meter map. You may also insert meter entries by pressing INS. 
Pressing ENTER or double clicking over the desired entry will allow you to change the meter of 
the currently selected entry. The DEL key is used to delete entries from the map. If there is only 
one entry in the map, you won't be allowed to delete it since a minimum of one entry is required in
the map.

Tempo Map
The Tempo Map is a list of all the tempo changes that occur during the course of the song. The 
Ins, Del, and Change buttons contained in the Tempo Map dialog box may be used to insert, 
delete, and change entries in the tempo map. You may also insert tempo changes by pressing the
INS, and you may change the tempo of the currently selected entry by pressing ENTER or by 
double clicking over the desired entry. The DEL key is used to delete entries from the map. If 
there is only one entry in the map, you won't be able to delete it since at least one entry in the 
map is required.

Comments Window

The Comments window is a simple text editor, which allows you to edit or view comments. The 
comments will be saved to a .SEQ file but not to a .MID file. You can cut or copy from the 
Comments window to the clipboard, or you can paste from the clipboard into Comments using the
commands in the Edit Menu.  

The following is a list of the editing commands:

HOME        =   Go to beginning of line
END        =   Go to end of line
^HOME      =   Go to beginning of text
^END        =   Go to end of text
UP             =   Cursor Up
DOWN        =  Cursor Down
PAGEUP    =   Up one page
PAGEDN    =   Down one page
RIGHT        =   Cursor Right
LEFT        =   Cursor Left
^RIGHT      =   Cursor Right one word
^LEFT        =   Cursor Left one word
INS        =   Toggle Insert Mode
DEL        =   Delete Character

Note: Command shortcuts like pressing the SPACE bar to play a song won't work within 
the comments window.
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SysEx Window
The SysEx Window is actually a built-in system exclusive (sysex) librarian, which allows you to 
transmit or receive sysex data. You may also load and save MIDIEX compatible sysex files. The 
sysex librarian can hold up to 24 banks of system exclusive data. Since the librarian stores all 
data on disk as opposed to memory, the size of the sysex data is limited only by the amount of 
free disk space.

Double click on the SysEx Icon to activate the SysEx window.   A Dialog box will appear.  On the 
right hand side of the SysEx window is a series of buttons that allows you to access the SysEx 
commands.

Receive: This command lets you receive a data dump from your synthesizer to the currently 
selected bank. When you execute this command, a message box will pop up to indicate that the 
sequencer is ready to receive the dump. You may then dump the data from your synth and all the 
data received will be stored in the current bank.  A dialog box (Receiving SysEx Data) will appear 
and show the progress of the dump ("Bytes Received:") When your synth is finished dumping the 
data, you may then press the OK button  to let the program know that the dump is finished.

Transmit: Sends the data in the current bank out via MIDI.  A dialog box (Sending SysEx 
Data)will  appear and inform you that a send is in progress. If you wish to cancel the transmission
after it has started, you may press the cancel button, and the transmission will be stopped.

Request: This option allows you to initiate a dump request by sending a dump request to your 
synthesizer. Simply choose an instrument from the available choices and press ENTER. You may
be prompted for the channel or patch numbers if the instrument requires them. After sending the 
dump request out the MIDI OUT port, the program will then receive any data that is sent from 
your synth as if the receive command had been executed.

Load: This command will load a MIDIEX compatible sysex file into the currently selected bank.

Save: This command will save the currently selected bank on disk in MIDIEX compatible format.

Name: Lets you choose the name for the current bank of sysex data.

Auto: When this option is enabled, the bank will automatically be transmitted via MIDI when 
loaded from a .SEQ file. The letter 'A' will appear to the right of the bank name in the SysEx 
window if the bank is to be Auto-Transmitted.

Port: This setting determines the output port through which the sysex data will be sent out via 
MIDI.  If the selected port is greater than the number of ports available, the data will be sent out 
the highest available port.  For example, if the port setting for a bank is set to '2' and there is only 
one MIDI output driver installed, the sysex data in the bank will be sent out through port 1.

Delete: This simply deletes the data from the currently selected bank.

Edit: This command is for experienced MIDI users who wish to edit the bytes of the currently 
selected bank. You can also type in sysex data if the current bank has no data in it.  A dialog box 
will pop up in which you can edit the bytes.  The bytes are edited as hexadecimal numbers.  The 
bytes are shown separated by spaces.  The sysex data will look something like this example: 'F0 
41 10 42 12 40 11 02 10 1D F7' . Each sysex message should start with 'F0' and end with 'F7'.   
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The following is a list of the editing commands you can use when editing sysex data:

HOME                 Go to beginning of line
END                 Go to end of line
^HOME    Go to beginning of text
^END                 Go to end of text
UP                 Cursor Up
DOWN                 Cursor Down
PAGEUP     Up one page
PAGEDN     Down one page
RIGHT                 Cursor Right
LEFT                 Cursor Left
^RIGHT     Cursor Right one word
^LEFT Cursor      Left one word
INS                 Toggle Insert Mode
DEL                 Delete text.
CTRL-X     Cut text to clipboard.
CTRL-INS     Copy text to clipboard.
SHIFT-INS     Paste text from clipboard.

Note: If you save a song to a .SEQ file, the sysex data will be saved within the file. However, if 
you save the file to a .MID, sysex information will not be saved.

Dump Request Macros
A Dump Request Macro (DRM) allows you to initiate a data dump of your synth from within 
PowerTracks instead of having to press a button on your synth. A DRM contains the name of the 
synth (the name will appear in a pick window when you execute the Initiate Dump Request 
command) and a packet of bytes that, when sent to your synth, will tell it to send a data dump.

When you use the Initiate Dump Request command, PowerTracks reads the dump request 
macros from a binary file called PT.INS. The file PT.INS was converted from a text file called 
PT.DRM, that contains the macros in ASCII format.

If you have a synth that isn't listed in PT.DRM, it is possible for you to add a macro for your synth 
if you are technically oriented. The macros are derived from the System Exclusive 
Implementation sections of synthesizer manuals. Writing new macros for PT.DRM is probably 
best suited for people with at least a little background in programming. 

PT.DRM File Format 

Lines that have a forward slash (/) in the first column are considered to be comments and are 
ignored when converting to PT.INS. Blank lines are also ignored.

Each Dump Request Macro must be on just one line. Each line must be precisely in the following
format:

'<DRM name>' [(<from>,<thru>,<step>)] F0 <MIDI data> F7

<DRM name> is up to 38 characters enclosed in single quotes. <DRM name> will be shown in 
the Instrument Pick Window. 
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(<from>,<thru>,<step>) is a loop command which is optional. The loop counter is incremented in
value starting with <from>, and ending with <thru>. The value of <thru> must be greater than 
<from>. The <step> value is the amount that the loop counter will be incremented on each loop. 
For example, (5,10,1) will loop from 5 to 10, incrementing the counter by 1 on each loop. 
Normally you will use 1 for the step value. The loop command should always be placed between 
<DRM name> and the F0.

If a DRM requires the value of the loop counter to be included somewhere within the bytes, place 
a capital letter L at that point within <MIDI Data>. It will be replaced with the loop counter value 
when the dump request is transmitted by PowerTracks.

<MIDI data> is a series of bytes that are used to tell the synthesizer that you are making a 
request to dump data. The format for the MIDI data itself comes straight out of the synthesizer 
manual's MIDI System Exclusive Implementation section. The bytes are in hexadecimal notation.

The following symbols are letters that may be placed within the <MIDI data> section to tell 
PowerTracks that certain information is needed:

c : You will be prompted to "Enter Channel/Unit Number". The data entered by you is 
transmitted.

L : Send the loop counter value. This counter is incremented each time through the loop. Don't 
use this symbol without the loop command.

P : You will be prompted to "Enter Patch Number". The data entered by you is transmitted.

R : Mathematically OR the two bytes that surround the R. The bytes immediately before and after
the "R" are OR'd together and the result is transmitted.

Note: The symbols above are case sensitive, which means they must be capitalized except
for "c" which must be in lower case.

Converting PT.DRM to PT.INS

PT.DRM must be converted to PT.INS in order for PowerTracks to be able to use any new macros
that you have written. This is done automatically when PowerTracks is started. If PowerTracks 
detects that PT.DRM is newer than the current PT.INS, it will convert PT.DRM to PT.INS.  Also, if 
PT.INS doesn't exist on disk but PT.DRM exists, PowerTracks will automatically convert it to 
PT.INS. 

PT.DRM should, of course, reside in the same directory as PTW.EXE. If an error is encountered 
in PT.DRM,  PowerTracks will notify you of the line number in which the error occurred. If no error 
occurred, PowerTracks will rename the old PT.INS (if it existed) to PT.BAK and then create a new 
PT.INS using the macros in PT.DRM.

Guitar Window
The guitar window displays notes (as green squares) that are played in the current track or MIDI 
Thru on a guitar fretboard.  It works in a similar manner to the piano below the toolbar.  However, 
since there are six separate strings on the guitar fretboard, and many notes can be played 
several ways on a guitar, it is little more complicated than the piano.   

Below the guitar fretboard are position markers. The current position is highlighted in reverse 
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video.  The positions range from 0 (open) to 24 (the 24th fret).  There is an additional position 
called 'All'.  When All is the current position, notes will be displayed in all possible ways that they 
can be played on the guitar. When the position ranges from 0 -24, the notes will be displayed in 
the current position, unless they are outside the range of the position, in which case they will not 
be shown.  You can change the current position simply by clicking on any position marker.  

The Insert Position button will insert the current position into the current track at the current 
location (Now:).  When you play back the track, the current position of the guitar will change 
when the track plays the position event.  A position event is stored in a track as a MIDI controller 
(number 84) with a value ranging from 0-24 indicating positions 0-24, and a value of 127 indicates
the 'All' position.  The ability to insert position information into a track is useful for properly 
displaying a track that was recorded by a MIDI guitar controller with all six strings set to transmit 
over one channel.  By inserting position information, you can have the guitar fretboard display the
notes in the position the you played them instead of having them shown in all possible positions. 

You could, if you are determined, record guitar music on a MIDI keyboard and then insert position
information to have the track be displayed as if it was played on a guitar. However, the best way 
to record guitar music is with a guitar controller that is capable of transmitting over 6 separate 
MIDI channels.  See the information on Multi-Channel mode below.

The Note Indicator is the white square to the right of the Insert Position button.  If you move 
the mouse cursor over the guitar fretboard, the name of the note that the mouse cursor (if any) 
will be shown in the white box. This is useful for getting to know the notes of the guitar. 

The Backup and Advance buttons (the ones with the '<' and '>' characters)let you advance 
forward or go backward by one note.  PowerTracks will play the note that you have advanced or 
backed up to.  You can stop the note from sounding by advancing or backing up to another note, 
or you can press the Stop Button.  This is useful for hearing and seeing a sequence of notes one 
step at a time. Keyboard shortcuts for backup and advance are Shift-Left Arrow and Shift-
Right Arrow. 

The Backup Group and Advance Group buttons (The ones with the '<-' and '->'  characters) 
work in a similar manner to the Backup and Advance buttons except they work on a group of 
notes.  Notes that are within a certain distance from each other (determined by PowerTracks) are 
considered to be a group of notes.  This is useful for hearing and seeing notes and chords be 
played one step at a time. Keyboard shortcuts for backup and advance are Shift-Left Arrow 
and Shift-Right Arrow. 

The Settings button will access a dialog box which will let you change the following settings of 
the guitar window:

The Note Display Options checkboxes determine if the guitar window displays notes on the 
current track or notes that are echoed out via MIDI Thru. 

When Multi-Channel mode is enabled (the default), and the MIDI channel of a note is within the 
guitar channel range (11-16 is the default), PowerTracks will assume that notes within the 
channel range fall on a particular string.  For example, in this case, a note on MIDI channel 11 will
be considered to be on string number 1.  The note won't be displayed if it is too high or too low for
the string.  The purpose if multi-channel mode is so that when you play back a track that was 
recorded by a MIDI guitar controller in Mono mode, the notes will display in the guitar window the 
same as they were played on the MIDI controller. If a note's MIDI channel falls outside the 
channel range, PowerTracks will use the position information to display the note.  

The Base Channel determines the guitar channel range when in Multi-Channel Mode. For 
example, with a Base Channel of 1, the channel range will be 1-6.  The highest possible base 
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channel is 11 (the default) in which the channel range is 11-16.

The Fretboard Color radio buttons let you choose between Brown or Black for the color of the 
guitar fretboard.

The Octave determines the range of notes that are displayed on the guitar fretboard.  When set 
to 0, the fretboard will display notes normally.  When set to, for example, -1, the guitar window 
can be used to display bass lines.

The String Tuning determines the range of notes that are displayed on each of the six strings.  
The default is standard E tuning.  You can change the note value corresponding to the open note 
for each of the six strings, and the guitar will then display notes as if they are played on a guitar 
with an alternate tuning.  The strings must be tuned from highest to lowest.  For example, string 
number 1 must be tuned higher than string number 2.  

All the guitar settings are saved to PTW.INI so that they will remain in effect the next time you use
PowerTracks. 

Mixer Window
The Mixer Window is a 16 channel MIDI mixer with support for Roland GS and General MIDI 
synths.  When in General MIDI mode, it can also be used with regular MIDI synths, assuming 
your synth will respond to some or all of the controller messages for Volume, Panning, Chorus, 
and Reverb. The Mixer uses two kinds of controls that aren't built into Windows:

Knobs  and Spin Controls
 
To use the knobs, simply click and hold down the left mouse button while the mouse cursor is 
inside of the knob and move the mouse cursor. The knob's pointer will follow the mouse cursor. 
Keep in mind that once you've held down the mouse button, you can even move the mouse 
cursor outside of the knob so that the mouse cursor isn't covering the knob's pointer.  When the 
knob is at the desired position, simply let go of the mouse button and the knob will stay at that 
setting.
To use the Spin Controls simply click the mouse on either the up or down arrow until the desired 
setting is shown.

The mixer's knobs and sliders will respond to any Volume, Pan, Chorus, and Reverb controller 
messages that are played in the sequence over the mixer's output port.

Any Volume, Pan, Chorus, and Reverb mixer adjustments made during recording will be recorded
in real-time as controller messages just like incoming MIDI data. Adjustments made in the All 
column of the mixer will not be recorded, however.

When recording mixer moves, it might be helpful to record the data on separate tracks from the 
musical data.  If Punch In mode is activated, recording will erase previously recorded data in the 
Punch in range without the need for you to erase the old data. 

Keep in mind that each column in the mixer represents a MIDI channel, and any adjustments 
made in that column will result in MIDI controller message being generated on that particular 
channel.  
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If you've made any mixer adjustments during recording, PowerTracks will ask you whether or not 
you wish to keep the recorded moves.  PowerTracks asks you whether or not to keep the 
recorded mixer moves, since you may have merely been making temporary level adjustments 
while recording music.  

The Reverb, Chorus and Pan knobs let you control the Reverb, Chorus, and Pan settings for 
each part.

The Reverb, Chorus, and Pan settings in the All column are master settings which control the 
overall level of each effect for the GS sound module. When in General MIDI mode, adjustments 
made to the settings in this column will change the settings for all 16 parts at the same time.   

The Volume controls let you adjust the volume of each part.

The Volume control in the All column is the master volume for the entire GS module.  When in 
General MIDI mode, this control will simply move all the faders at the same time.

The Part Numbers at the bottom of the screen show which part is associated with each column 
of the mixer. At program start-up the part numbers range from 1 to 10. The MIDI channel of each 
part is always equal to the part number.

The Current Part is the one in which the part number is highlighted in black. At program start-
up, Part 1 is the current part. The current part can be changed by clicking on the part number, or 
if you edit any of the settings of a part, the current part will automatically change to the one that 
you're editing.
The  and  buttons let you choose the range of parts from 1 through 10 or 11 through 16. When the
range is 11 through 16, parts 1 through 4 will be associated with the remaining part columns.

The Effects combo boxes let you select the type of Reverb and Chorus. These settings only 
work for Roland GS synthesizers.

The Port number is the output port for the mixer. All adjustments will be sent out over the mixer's
current output port. In addition, the mixer will only follow controller changes in the sequence that 
are sent out over the mixer's port.

The Settings Section is located at the top right area of the mixer screen.

The Module Select combo lets you choose between Roland GS and General MIDI. When in 
Roland GS mode, the Mixer communicates with your synth via System Exclusive messages if 
there is no equivalent controller message. When in General MIDI mode, the Mixer uses MIDI 
controller messages.  Some features such as the Pan, Chorus, and Reverb in the All mixer 
column, Chorus Type and Reverb Type combo boxes, and the Sound Editing section only will 
work with Roland GS synths. 

The Tune knob lets you tune your synth. When you click on the tune knob, you'll hear an A note 
sent out to the current part. Adjust the knob until the module is in tune and then release the left 
mouse button.  If you wish the A note to be sustained for as long as you're holding down the 
mouse button, make sure the current part has a patch with infinite sustain such as an organ 
sound.
The ID number is the unit ID number of your synthesizer. This is normally 17 for Roland GS 
synths. This number is sent with sysex messages, and your synth will only respond to sysex 
messages with the correct ID number.

The Reset button initializes the settings of your synthesizer.
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The Sound Editing section is in the lower right area of the screen. This has knobs for adjusting 
the Modulation, Filter, and Envelope parameters of your Roland GS synthesizer. When you 
make adjustments to the knobs, the current part will be affected by any changes you have make. 

The  button lets you edit additional settings for the current part. The other settings are 
Modulation Pitch Depth and Bend Range. A dialog will pop up in which you can change these 
settings. The modulation Pitch Depth is only supported in GS mode, but the Bend Range setting 
is sent in both GS and General MIDI Mode.

Notation Window
The notation window displays the notes of a song on a staff. The notation window has two 
modes of operation: Standard Notation mode and Staff Roll mode. When in Standard 
Notation mode, the Notation Window shows the track as regular music in standard notation. 
When in Staff Roll mode, the Notation Window is a hybrid between a piano roll and staff.

By default, the Notation Window is in Standard Notation mode. Pressing the N button will 
toggle the window between Standard Notation Mode and Staff Roll mode. It will be obvious 
which mode is in effect, since Standard Notation mode displays the notes as regular music, while 
the Staff Roll mode displays the notes as noteheads (no stems) with optional duration lines.  Also,
the Staff Roll mode will contain gray vertical lines across the staff.

Standard Notation Mode

The purpose of Standard Notation mode is to provide a convenient way of displaying a track as 
regular music on a staff within PowerTracks. The Notation Window is not a substitute for full-
blown scoring or notation software. PowerTracks is first and foremost a sequencer (not a scoring 
program).

Editing of music cannot be done in Standard Notation mode. To edit the music, the window must 
be in Staff Roll mode.
 
Currently, the time signatures supported by Standard Notation mode are 1/4, 2/4, 3/4, and 4/4.  If 
the song contains any measures with an unsupported time signature, the measure will be drawn 
as blank when in Standard Notation Mode. Staff Roll mode supports all time signatures supported
by PowerTracks Pro.

There are some options in a dialog box which can be accessed by pressing the OPT button. 

When in Standard Notation mode, the Resolution setting determines how the program rounds 
the note times and durations when translating a track into standard notation. For example, a 
resolution of 4 will cause the program to round each note and duration to the nearest 16th note 
when displaying the music (in 4/4). A resolution of 3 will cause PowerTracks to round each note to
the nearest 8th note triplet (in 4/4). A resolution of 2 will cause PowerTracks to round each note to
the nearest 8th note (in 4/4).
Hint: If you're displaying  jazz swing or shuffle music that has a triplet feel to the eighth notes, 
make sure to set the resolution to =3 (triplets). This will display the 8th notes and other aspects of
jazz swing music correctly. 

The following 3 settings are for Standard Notation mode only, and don't have any effect in Staff 
Roll mode:

The Minimize Rests checkbox, when checked, will cause PowerTracks to display the music with 
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minimal rests. Use this setting if notes are displayed as shorter than you intended. For example, if
eighth notes are displayed as sixteenth notes because you recorded them staccato.

The Clefs Split At setting determines the split point for placing notes on the Bass or Treble clef.  
The default setting is 'C 5' which is middle C. For example, you can use a higher split point, such 
as 'C 6' if you want some notes up to a G above middle C to be displayed on the bass clef with 
ledger lines instead of on the treble clef. If the split point is above middle C, and a note in the 
music is high enough that any of the ledger lines above the bass clef would overwrite the treble 
clef, the note will be placed on the treble clef. 

The Tick Offset lets you display the music ahead or behind the beat. If you have a tendency to 
play the music ahead of the beat, you can specify a setting from 1 to 120 to have the music 
displayed forward in time. A setting from -1 to -120 will cause the music to be displayed ahead of 
the beat  (but not before the beginning of the song). 120 ticks equals one quarter note for this 
setting regardless of the current PPQ setting. Generally you won't need to use this setting since 
the notes are rounded when being displayed in standard notation.  

Hint: The notation of Jazz swing music will often be improved by a Tick Offset setting of about -5. 
(minus 5) This is because jazz music is typically played a little after the beat.

See the information on the Staff Roll mode below for more settings in the Notation Window 
Options dialog.

Staff Roll Mode

Staff Roll mode is a similar to a piano roll, except the notes are shown on a grand staff.  Its 
purpose is to allow for easy graphical editing of notes, and not to display the music in regular 
notation.  With the Staff Roll, you will be able to graphically edit sequences much easier than if 
you were using a regular piano roll or an ordinary notation window.
Notes are shown as black dots (note heads) on the staff.  Notes are not shown with stems.  If the 
Show Note Durations setting (discussed later) is enabled, the durations of the notes are shown as
horizontal lines. The horizontal duration lines are drawn a little higher or lower if the note is a 
sharp or a flat, which helps you be aware of rare situations where notes a half step apart overlap 
each other. Notes are shown with sharp, flat, or natural symbols depending on the key signature 
of the song.  Notes are shown exactly where they occur. They are not quantized.
Notes can be inserted simply by clicking on the staff in an appropriate location. You will see the 
name and octave of the current note location in a box at the top of the window.  This helps if you 
are inserting a note above or below the grand staff.  You can also insert notes via the Piano or 
Guitar Window as discussed later in this section. Notes can be deleted by holding down the 
Delete key and then clicking over the note you wish to delete.  Notes can be edited by clicking on 
the note with the right mouse button.  If you click on notes that are overlapping each other while 
attempting to edit or delete a note, a dialog box will pop up that will let you choose which note to 
edit or delete.
Notes can be moved via drag and drop. To move a note, move the mouse cursor over an existing 
note and then click and hold the left mouse button. The mouse cursor will change to a different 
shape. While keeping the mouse button pressed, move the mouse cursor over to the location you
wish to drop the note and then let go of the mouse button.  The note will be moved to the place 
you dropped it.  Certain areas of the screen are not valid locations to drop a note.  The mouse 
cursor will change to a circle with line through it to indicate an invalid location.  If you try to drop a 
note in an invalid location, nothing will happen.     
There are some options related to how notes are displayed.  These options are in a dialog box 
which can be accessed by pressing the  button.  In this dialog, if the Show Note Durations 
checkbox is checked, then the durations of notes will be shown as either green or blue horizontal 
lines depending on whether the Duration Color is set to green or blue.  
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The Quarter Notes Per Screen setting determines the horizontal resolution of the screen.  For 
example, with 4 Quarter Notes Per Screen, the width of the screen is equal to 4 Quarter Notes or 
one measure in 4/4.  At 8 Quarter Notes Per Screen, the width of the screen is equal to 8 Quarter 
Notes or two measures in 4/4.  You can have a setting as low as 1 Quarter Note Per Screen or as
high as 64, although the screen may look unusual at the extremes since the size of the note 
heads remains the same regardless of this setting.

The Resolution setting determines how many vertical grid lines will be drawn for each beat. For 
example, with a resolution of 1, just one line will be drawn per beat.  With a Resolution of 4, 4 
lines will be drawn, with 1 line being the beat line drawn in a solid color and the other lines being 
dashed lines representing sixteenth notes in 4/4.

The Transpose setting lets you adjust the Notation window to display notes either higher or lower
than their actual pitches.  For example, if you're working with guitar music, you could set this to 
+12 and the guitar music will be displayed an octave higher, which is the way guitar music is 
normally notated. 

Hint: This setting is also useful for displaying music for non-concert instruments such as trumpet 
or saxophone. Trumpet players (and other Bb instruments) should set transpose to +2, Alto 
Saxophone (and other Eb instruments) should set the transpose to -3. The music is then 
displayed in the correct key for the instrument, but plays in the concert key to the MIDI card.

If the Snap To grid lines checkbox is checked, the inserted note will be lined up with the closest 
grid line (quantized). 
The duration of inserted notes is determined by which check box at the top of the screen is 
checked. The Duration % Setting causes the durations to be set to a percentage of the currently
selected duration.  For example, if the current duration is Whole, and you set the percentage to 
50, the duration will be half the length of a Whole note. If the Auto checkbox is checked, the 
duration will be automatically set by the program so the note lasts up to the next note in the 
measure or to the end of the measure, which ever is closer, and multiplied by the percentage. If 
Auto is checked and you insert a note in a spot in a measure before a previous note or chord in 
the measure ends, the previous note or chord will be shortened so it doesn't overlap the currently 
inserted note. The Channel and Velocity settings determine the MIDI Channel and velocity of 
inserted notes. If the Play Inserted Notes checkbox is checked, notes that you insert will sound 
briefly as they are inserted. This lets you hear that the note you inserted sounds correct. 
You can change the Key Signature of the song by clicking on the key area of either the treble or 
bass staff to the right of the clef symbol.  Or, you can simply double click on the Key setting in the 
Tool Bar at the top of PowerTracks Pro's main screen.
During playback, notes are highlighted in red as they are being played.  In addition, a vertical 
black line at the top of the screen will indicate the current location of the song during playback.  
When playback is stopped you can click on the top of the screen below the duration checkboxes 
to change the time of the song. 
You can also insert notes by clicking on the Piano or the Guitar Window.  If you click on the 
Piano or Guitar Window, notes will be inserted into any open Notation window at the current 
location in the Notation window. For example, if you click on middle C of the Piano keyboard, a 
middle C will be inserted into the Notation window.  

Note: By default, you must hold the Ctrl key before clicking on the Guitar fretboard to insert a 
note into a Notation window.  If the Send Notes To Notation Windows options in the Guitar 
Settings dialog is enabled, holding the Ctrl key won't be required, but be careful not to 
accidentally insert a note when using the mouse to switch to the Guitar window.     
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The Help Menu
The Help Menu lets you access the on-line help file (PTW.HLP).

Help Index

This command will access the help file and show you an index of topics. Simply click on the topic 
name you wish to choose and the topic will be displayed.

Using Help

This command accesses the MS Windows help file, which gives you some tips on how to use the 
Windows help system.

About PowerTracks

This command will display a dialog box that contains version and copyright information regarding 
PowerTracks.

Chapter 4: Synchronization
PowerTracks has the ability to synchronize to an external source such as MIDI Sync (MIDI 
Clocks with Song Position Pointer), or MIDI Time Code. This chapter will discuss synchronizing 
the sequencer to various external sources.

Syncing to MIDI

To sync with a MIDI device such as a drum machine: 

 1) Set the Sync Source in the Options Menu to MIDI. Make sure your drum machine is 
configured                                                                                                                                          
to send MIDI clocks and Song Position Pointer.                              

 2) Set PowerTracks to play or record, and it will wait for a MIDI start or MIDI continue to be sent  
      from the drum machine. 

 3) Start playback of your drum machine and PowerTracks will automatically find the proper          
      location within the song and start playing in sync. with the drum machine.. 

Syncing to MTC/SMPTE

PowerTracks is capable of syncing to MIDI Time Code (MTC).  There are some converter devices
and MIDI interfaces which have the ability to convert SMPTE time code to MIDI Time Code.  
When using such a converter or interface, PowerTracks simply sees a stream of MTC messages, 
thus allowing the sequencer to sync to SMPTE.  If you are using a converter or SMPTE capable 
interface, see your hardware instruction manual for specific information on using your hardware to
sync to MTC/SMPTE.  
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To sync to MTC/SMPTE:

1) Set the sync source in the Options Menu to MTC/SMPTE.

2) Go to the Options Menu, and select SMPTE. You must then select the SMPTE format that 
you're syncing to, and enter a SMPTE offset. We recommend using an offset of at least 2 
seconds (00:00:02:00). In this case, the beginning of the song will correspond to 00:00:02:00.

Note: Sometimes a studio will stripe a tape starting at, say, 23:59:57:00, and the music is 
supposed to begin when the SMPTE time "rolls over" to "midnight "(00:00:00:00). When 
using such a tape, always make sure that the SMPTE offset is set to 00:00:00:00.  
PowerTracks will start the music when the time code reaches midnight. 

3) Activate Play or Record, and the sequencer will wait to receive the time code. 

4) If you haven't already, see the instructions that came with your SMPTE to MTC converter or 
you                 MIDI interface.  The instructions should tell you how to enable your hardware for 
syncing to SMPTE/MTC.  You should follow the instructions so that your hardware will be able to 
transmit the MIDI Time Code to PowerTracks when you've started playback of your tape deck. 

5) Start playback of your tape machine, and the sequencer will automatically find the proper 
location within the song and start playing in sync with the tape machine.

Chapter 5: Trouble-shooting
This chapter will discuss potential problems that you may encounter when using PowerTracks.

Computer Freezes During Input or Isn't Recording/Echoing 

If the computer freezes or PowerTracks isn't recording or echoing any MIDI data, it is possible 
that you have an IRQ conflict. What this means is that your interface and some other device such 
as a video card, a clock/calendar card, or a bus mouse could both be fighting to use the same 
IRQ. If you think you may have an IRQ conflict, your interface manufacturer might be better able 
to help you since the problem isn't software related. 

Most MPU-401 compatible cards normally use IRQ 2. You should read the documentation 
supplied with your hardware to see if any other device is using IRQ 2. If another device is in fact 
using IRQ 2, the ideal solution is to change the IRQ of the other device to a different IRQ such as 
IRQ 5. Check the device's documentation to see if the device can be configured to use another 
IRQ. Some EGA/VGA video cards use IRQ 2 but allow you to disable the usage of IRQ 2 by 
flipping a switch on the card.

Instead of changing the IRQ of the other device, you could consider changing the IRQ of your 
MIDI interface to a different IRQ. Some MIDI interfaces don't allow you to change the IRQ, so this
might not be a possible solution. If your interface does have a switch or jumper for changing the 
IRQ, you will have to change the IRQ setting on both the interface and any MIDI software that you
use. While most windows drivers let you change the IRQ setting some DOS MIDI software 
(especially some public domain) might not let you use a different IRQ.

If the DOS version of PowerTracks has worked fine before, but suddenly isn't recording MIDI 
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data, make sure the Channel Filter is set to record on the channel with which your synth is 
transmitting the data.

If you don't hear MIDI data being echoed via MIDI Thru, check your MIDI Thru settings in the 
Options Menu. If Track-Specific MIDI Thru is enabled, don't forget that the MIDI data will be 
echoed out using the velocity, port, channel, and key transposition settings of the current track. 

Double-Triggering of Notes

If you experience double-triggering, the notes you play on your synth are being sent to your MIDI 
interface and are echoed back to the MIDI IN port of your synth. This will cause your synth to 
trigger the notes a second time. PowerTracks sends a MIDI Local Off command to your synth 
during program start-up or whenever MIDI-THRU is enabled to prevent double-triggering from 
occurring. Since some synths don't respond to the Local Off command, try disabling MIDI-THRU 
within PowerTracks or you could try manually switching your synth into Local Off Mode (if your 
synth supports this feature).
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Chapter 6: PowerTracks for DOS 
PowerTracks gives you the best of both worlds by including both a Windows and DOS version in 
one package. This chapter will discuss some of the important differences between  PowerTracks 
for Windows and PowerTracks for DOS. Since the DOS and Windows versions are similar, if 
you're familiar with one version, you should easily be able to use the other version.  

There is file called DOSMAN.DOC which contains complete documentation for the DOS version. 
You can be print this manual out on your printer or view with a text editor. Like the Windows 
version of PowerTracks, the DOS version also has on-line help which can be accessed by 
pressing F1.  

Requirements

The DOS version will run on 8088 based machines w/ 512K RAM, while the Windows version 
requires at least a 286 with 2 megabytes of RAM. While the Windows version uses more memory,
it isn't limited to 640K like the DOS version. If you have a machine with a lot of memory, such as 8
mg, you will be able to access all of this memory with the Windows version.  If you're like most 
users, the songs you're working on will fit into memory with either the DOS or Windows version. 

Text vs. GUI
The DOS version of PowerTracks has a character based user interface as opposed to a 
Graphical User Interface (GUI). While character based displays may not look as pretty as a GUI, 
the display is generally faster.

You won't see things such as push buttons, radio buttons, and, with a few exceptions, scroll bars 
in the DOS version.  Instead of a tool bar at the top of the screen, there is a status section at the 
bottom of the screen. The DOS version is still very easy to use and intuitive.       

Menu Commands
The menu commands are very similar in the DOS and Windows versions.  A few of the 
commands have been renamed, such as the Write Buffer command, which has been renamed to 
Save Scrap in the Windows version.  There are a few additional command shortcuts in the DOS 
version like ^-P, which will play the song from the beginning.  

Screens vs. Windows
The DOS version doesn't have resizable windows.  The Track, Bar, and Sysex displays are 
entire screens in the DOS version. These can be found in the screen menu.  Only one screen can
be displayed at a time. 

The screens in the DOS version will look slightly different than their Windows counterparts. For 
example, the Bar Screen uses dots to indicate a blank measure, while the Bars Window uses a 
blank rectangle.  

The Tempo Map, Meter Map, Event List, and Comments can be accessed from the Edit menu.
These are pop-up editors as opposed to entire screens. 

Summary 
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While there are some differences between the DOS and Windows versions of PowerTracks, the 
programs are very similar. You should be able to use either version with little difficulty.  The on-
line help will assist you while using the DOS version, and complete documentation 
(DOSMAN.DOC ) is included on disk.    

Chapter 7: Technical Support
Technical Support phone number 416-528-7043
Technical support is available 10:30 AM - 6:30 PM Eastern time.
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Chapter 8: Newest Features
CHANGES SINCE VERSION 2.1 

NEW COMMANDS:

Action - Cache Patches Now

If you are using an output driver that requires patch caching, this command 
will cause PowerTracks to update the patch cache.  You should use this 
command if you have made changes to the patches that a song uses. In order 
to update the patch cache, PowerTracks must scan the currently loaded song 
for patch changes.  To save time, PowerTracks does not scan the entire file 
for patch changes.  Instead PowerTracks scans the beginning of each track. 
The first 5 events of each track are scanned, or all events that have a 
time of 1:01:000, whichever is greater. If a track has a forced MIDI 
channel of 10, or any of the scanned events at the beginning of the track 
have a channel number of 10, then PowerTracks does scan the entire track 
for drum notes.  PowerTracks will also scan the Tracks window for patch 
changes.  When PowerTracks updates the patch cache for a track, the cache 
is updated based on the MIDI Output Port for the track.  If any of the 
tracks are using an output port that does not require patch caching, such 
as the MPU-401, then the track will not be scanned for patches.

Action - Juke Box

The command lets PowerTracks play a list of songs. A dialog box will pop up 
that lets you choose which songs to be played.

The Play List String field contains a list of songs to be played by 
PowerTracks.  Wild cards are allowed. For example if the Play List String 
is '*.*' then all .MID and .SEQ files in the current directory will be 
played. Only files with the .MID or .SEQ extension will be loaded if the 
extension of filename is a wild card. The current directory is shown at the 
right of the dialog's title. You can specify several files to search for by 
separating them with a semicolon character. For example, if the Play List 
String is : 

'C:\WINDOWS\CANYON.MID;C:\PTW\*.SEQ;C:\MIDIFILE\*.MID' 

PowerTracks will first play CANYON.MID followed by all the .SEQ files in 
the PTW directory, followed by all the .MID files in the MIDIFILE 
directory. The Play List String can be up to 1024 characters long.

When the Random checkbox is checked, PowerTracks will play all the files in 
random order. The Open button lets you load a .JUK file.  A .JUK file 
simply contains a Play List String.  If you save a .JUK file with the Save 
button, the current Play List String can be saved to a .JUK file. If you 
later load the .JUK file with the Open button, the Play List String in the 
file will appear in the Juke Box dialog.

The Add to Play List button lets you add a file to the play list from a 
File Open dialog without having to type the file name into the Play List 
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String field.

The OK - Start Juke Box button will close the Juke Box dialog and start 
playing the songs in the play list.  If you typed an invalid file names in 
the Play List String field, the program will inform you of the error so you 
can correct it. When the Juke Box is playing, the window title of 
PowerTracks will have the words '(Juke Box)' shown to the right of the file 
name.  If you stop playback while in Juke Box mode, the Juke Box will be 
stopped and PowerTracks will be back to normal.

Edit - Change Velocities

This command lists you increase or decrease the velocity values of notes 
within the marked area of all selected tracks by a specified percentage. 
The Percentage setting determines how the velocity values are changed.  For 
example, percentage of 100% results in no change.  A percentage of 50 would 
reduce the velocity values by half.  A percentage of 125 would increase the 
velocity values in the track by 25%.

Edit - Velocity Dynamics

This command will 'compress' or 'expand' the velocity values of notes 
within the marked area of all selected tracks. PowerTracks will determine 
the average velocity of all notes with the marked area.  The Percentage 
setting will cause the velocity values to be moved either closer or farther 
away from the average velocity.  A percentage of 100% results in no change.  
A percentage of 50% would compress the velocity values so that they are 50% 
closer to the average velocity.  For example, if the average velocity is 
64, and a note has a velocity of 84, the notes velocity will be moved 
midway between 64 and 84 to become 74.  A percentage of 150% would expand 
the velocity values so that they are 50% farther from the average velocity.  
For example if the average velocity is 64 and a note has a velocity of 84, 
the note would be moved 50% farther away from 64 than 84 to become 94.  

In the examples above, the velocity value used was above average. Keep in 
mind that velocity values that are below the average will be increased when 
compression occurs and decreased when expansion occurs.

Options - Endless Loop

When this option is enabled, PowerTracks Pro will automatically loop back 
to the beginning of the song when the song reaches the end. This setting is 
not saved to PTW.INI or to .SEQ files.

OTHER CHANGES SINCE 2.1:

OPTIONS - MIDI OUT

Two new settings in the MIDI OUT dialog:

CACHE PATCHES WHEN PLAYBACK IS STARTED:  If you are using an output driver 
that requires patch caching, PowerTracks Pro will update the patch cache 
when a .MID or .SEQ file is loaded.  If this setting is checked, and you 
are using an output driver that requires patch caching, PowerTracks Pro 
will update the patch cache every time playback is started.  Enabling this 
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setting will cause the sequencer to take longer to start playback, so 
enable this setting only if you have a special need for it. This setting is 
saved to PTW.INI.

SYSEX DELAY: when multiple packets of system exclusive data are sent, some 
synthesizers require a delay between packets.  If your synth requires a 
delay, then this setting lets you specify a delay between 1 and 100 
milliseconds. The default setting is 0 for no delay.

WINDOW | NEW COMMAND

The New command will not create a duplicate Notation Window or duplicate 
single-track Event List window since there is no reason for doing so in 
PowerTracks. For example, if you already have a Notation Window open for 
Track 1, and you try to open another Notation Window when track 1 is the 
current track, a second track window won't be created.  Instead, the first 
notation window will be brought to into view and become the currently 
activated window.  The same goes for Event List windows except that 
PowerTracks only checks for duplicates if the Event List is for one track; 
not for multiple tracks such as tracks 1,2, and 3.

NOTATION WINDOW

If the Highlight Played Notes checkbox is checked, notes will be 
highlighted in red as the notes are played when a song is playing.  If you 
have a slower computer or a track is very dense, you can save PowerTracks 
some extra work by unchecking this setting.

GUITAR WINDOW

The Guitar window now defaults to position 0 (the open position) instead of 
the All position which showed the notes in all possible positions.

TOOL BAR

The Tool Bar now has a button for creating a Notation Window.
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Power Tracks    Info    
Power Tracks is copyrighted and
is the property of PG MUSIC INC.

All rights reserved

U.S.A. mailing address

PG MUSIC INC.
266 Elmwood Avenue Suite 111
BUFFALO, NY 14222

Canada mailing address

PG MUSIC INC.
32 Hess Street South
Hamilton, Ontario
Canada L8P 3N9

Phone (800) 268-6272 or (416) 528-2368
Fax  (416) 628-2541

Other PG MUSIC Inc. Products

We have other computer Music Programs for IBM (DOS/Windows), MAC and ATARI.

These include:
Band-in-a-Box Pro (Windows/DOS/MAC/Atari):
Automatic Accompaniment Software
Type in the Chords to any song, using standard chord symbols (like C or Fm7), choose a style 
and press PLAY.  Band-in-a-Box then generates a complete, professional quality 5 piece 
arrangement of bass, drums, piano, guitar, and strings to be played back through MIDI or your 
sound card.  PC Magazine technical excellence award finalist Jan 91 (After Hours) .  Add on Style
and Song Disks available for Band-in-a-Box.

The Pianist for Windows (also MAC/ATARI)
The  Pianist is a Music Program containing a huge collection of over 200 of the world's most 
popular classical piano pieces, performed by world-class concert pianists!  Plus. Music Trivia 
Game, "Guess the Song", Program Notes, Biographies, Music Dictionary (all on disk)... and much
more.   All the pieces have been recorded "in real time" by concert pianists on an 88 mote 
weighted MIDI Piano keyboard.  All are complete artistic performances professionally performed, 
recorded and saved as Standard MIDI files.  You'll hear the music playing with CD-quality through
your sound card or MIDI system, just as if the pianist was in your home.

The Jazz Guitarist for Windows (also MAC/ATARI)
This software makes it "too easy" to learn to be a great jazz guitarist. 
The Jazz Guitarist is a Music Program containing a large collection of over 60  Jazz Standards 
performed by Top Jazz /Studio Guitarist Oliver Gannon !  The pieces have all been recorded live 
on a MIDI Guitar . You can playback the pieces in real time , or slow them down , or better still - 
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step through them one note or one chord at a time .You see the Guitar notes displayed on a 
fretboard on the screen , so you can see exactly what notes are being played on the Guitar 
Plus...On Screen Chord library, Jazz Guitar Trivia Game, "Guess the Song", Program Notes, 
Biographies, (all on disk).... and much more. 

SC-PRO Editor for Windows
Editor /Librarian for Roland SC series (Sound Canvas/SCC1/GS etc.)
Allows you to edit all the sounds and other features of your Roland module.
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Registration 
Take a moment to complete the Registration information and mail to PG Music Inc. 266 Elmwood 
Ave. Suite 111 Buffalo New York 14222 or fax your registration information  to 416 -628-2541.  
Registered customers will receive information about ordering these products and our other new 
products currently in development.  Contact us for further information.

POWER TRACKS REGISTRATION CARD
mail to PG Music Inc. 266 Elmwood Ave. Suite 111 Buffalo NY 14222

Name:...............................................................................................................................

Address:............................................................................................................................

State/Zip:...........................................................................................................................

Phone No:..........................................................................................................................

Purchased from::...............................................................................................................

Computer:..............................................................Windows.......................DOS...........

Interface Type:...................................................................................................................

Comments/Suggestions:.................................................................................................
..................................................................................................
...................................................................................................
...................................................................................................
...................................................................................................
...................................................................................................
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OPTIONS.SEQ, 24
1-Track Paste, 15
About PowerTracks, 41
Action Menu, 18
Arrange Icons, 26
Auto Sync Chase, 23
Bank Change, 27
Bars window, 12, 27
Block Menu, 20
Cascade, 26
channel aftertouch, 16
Clipboard, 15, 28, 30
Close All, 26
command shortcuts, 10
Comments window, 28
controller changes, 37

49



Copy, 15
Cut, 15
Data Filter, 14, 15, 16
Default Options, 24
DOS version of PowerTracks, 39
double-triggering, 37
drivers, 6, 7
Dump Request Macros, 30
Duplicate, 18
Edit Menu, 14
editing, 5, 10, 12, 14, 20, 23, 27, 28, 34
Erase, 18
Erase Data Only, 18
Event List,  10, 12, 24, 38
Events, types of, 25
Exit, 14
file formats, 11
File Menu, 13
Fill, 16
From = Now, 20
From = Value, 20
From and Thru, 10, 20, 21
function keys, 10
Go to Time, 19
Guitar Window, 31
help, 9, 35
Help Menu, 35
Hide Piano, 23
Index (Help), 37
installation, 5
IRQ conflict, 36
key, 22
key aftertouch, 9, 26
Key Signature, 9, 10, 20
key transposition, 27, 37
Length, 16
Load Mixer Settings, 14
Load Scrap, 13
loading, 11
Local Off, 37
looping, 11, 27
marking, 12, 20, 27
menu bar, 9
Meter, 20, 25, 28, 39
Meter Map, 28
Metronome, 21
MIDI channel, forced, 27
MIDI Devices, 7, 8, 22
MIDI files, 11,13, 15
MIDI Out, 21
MIDI Sync, 23, 35
MIDI sync, 23
MIDI Thru, 19, 21, 22, 31
midnight rollover, 36
Mixer Settings - Saving and Loading, 14
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Mixer Window, 33
MPU-401, 6, 7,
MTC/SMPTE, 18, 23, 35, 36
New (File | New), 13
New (Window | New), 24
Notation 34
note strings, 10
notes, 14, 16, 17, 18, 24, 27, 31, 32, 33, 37
Now Field, 9
Open, 13
Options Menu, 20, 36, 37
Panic, 19
Paste, 15
Patch Names, 22, 25
Piano, 10, 23, 24
Piano Roll (Staff Roll ) Window 34
Piano Settings, 24
pitch bend, 16, 21, 25
Pitch Transpose, 16
Play, 11, 18, 23, 25, 26, 39
Play From Start, 18
port, output, 5, 6, 29
program change, 11, 25, 27
PT.DRM, 30
PT.DRM file format, 30
PT.INS, 31
Punch In, 9, 22, 33
Quantize, 14
Record, 11, 18, 19, 36
Record From Start, 19
Replace, 16
Resolution, 23
Save, 13
Save As, 13
Save Mixer Settings, 14
Save Scrap, 14
Slide, 16
SMPTE, 21
solo mode,  9, 12
Sound Blaster, 7, 8, 
Step Record, 19
Stop, 11, 18, 19, 21, 23, 25, 32
Sync Chase, Auto, 23
Sync Source, 23
synchronization, 35
SysEx window, 29
system exclusive, 11, 29, 30, 31, 34
Tempo, 20
Tempo Map, 28
Thru = Now, 20
Thru = Value, 20
Tile, 26
time display formats, 10
tool bar, 9
Track Menu, 18
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track name, 18, 27
Tracks window, 26
tracks, current, 12
tracks, selected, 12
tracks, selecting, 12
Trouble-shooting, 36
Undo, 17
Using Help, 35
velocity transposition, 11, 27
wheel, 21, 26
Window Menu, 24
Please send in your Registration card ( on page before the index )
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